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1. GENERAL SOFTWARE USE AGREEMENT 
 

In return for payment of the applicable fee, CoreStar International Corporation grants the 

Customer license to utilize the software, subject to the following conditions: 
 

2. USING, COPYING, AND MODIFYING SOFTWARE 
 

� Customer may use the software on any one computer that operates with a CoreStar 

hardware key. 

� Customer may copy software as required to support normal media reliability 

requirements. 

� Customer may use software only as provided. 

� Customer may not reverse assemble or de-compile the software. 
 

3. COPIES 
 

� Customer may make unlimited copies of the software for archival purposes. 

� Customer agrees that no warranty, installation or training is provided by CoreStar 

International for any copies made by Customer unless otherwise agreed by CoreStar 

International. 

� All copies of the software must bear the copyright notice(s) contained in or on the 

original. 
 

4. OWNERSHIP 
 

� Customer agrees that it does not have any title or ownership of the software. 

� Customer acknowledges and agrees that the software is copyrighted and protected 

under the United States and International copyright laws. 
 

5. TRANSFER OF RIGHTS IN SOFTWARE 
 

� Customer may transfer rights in the software to a third party only if written consent is 

granted by CoreStar International Corp. 

� Customer may transfer rights in the software to a third party only as part of the 

transfer of all rights and only if Customer obtains the prior agreement of the third 

party to be bound by the terms of this License Agreement. 

� Upon such a transfer, Customer agrees that its rights in the software are terminated 

and that it will either destroy its copies or deliver them to the third party. 

� Upon such a transfer, Customer agrees that it must also transfer the hardware key. 
 

6. SUB-LICENSING AND DISTRIBUTION 
 

� Customer may not sub-license the software or distribute copies or adaptations of the 

software to the public in physical media or by telecommunication without the prior 

written consent of CoreStar International. 
 

7. TERMINATION 
 

� CoreStar International may terminate this software license for failure to comply with 

any of these terms provided CoreStar International has requested Customer to cure 

the failure and Customer has failed to do so within thirty (30) days of such notice. 
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8. UPDATES AND UPGRADES 
 

� Customer agrees that the software does not include updates and upgrades which 

may be available from CoreStar International under a separate support agreement. 
 

9. EXPORT CLAUSE 
 

� Customer agrees not to export or re-export the software or any copy or adaptation in 

violation of the US Export Administration regulations or other applicable regulation. 
 

10. RESPONSIBILITY 
 

� The customer is responsible for the hardware key.  If this key is lost CoreStar 

International will not replace it. 
 

11. LIABILITY 
 

� In no event shall CoreStar International be held liable under any circumstances for 

loss of profits or other contingent, consequential, or special damages arising out of 

the use of or inability to use CoreStar products even if CoreStar International Corp. 

has been advised of the possibility of such damages. 
 

12. ERRATA 
 

� EddyVISION 32 release 6.5 runs only on Windows 2000 Pro, Windows XP Pro SP 2 

or higher, and Windows Vista; 

 

� EddyVISION 32 release 6.5 makes use of a three (3) button mouse; certain features 

are not available to users with a two (2) button mouse; 

 

� EddyVISION 32 release 6.5 requires at least 64meg of ram, 1024x768 pixel display, 

a 200MHz Pentium-type processor, and a 10Gb hard drive with at least 100Mb free 

space. 
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1 Overview 
 

This manual describes how to configure and operate the CoreStar OMNI-200 eddy 

current tester.   

1.1 Terminology 

 

Throughout the document, the phrases “tester turned on” and “tester turned off” mean the 

software was made to read data and stop reading data respectively. The phrase “tester 

powered on” and “tester powered off” will mean the tester was physically powered on or 

off (i.e. the POWER button on the front panel was pressed to the left to power it on or 

right to power it off ).  

1.2 User-Interface Conventions 

 

The following conventions are used throughout the CoreStar EddyVision suite anywhere 

a value can be changed via mouse clicks: 

 

MOUSE CLICK ACTION 

Left-click Increase the value (usually by 1). 

Shift+Left-click Increase 10 times faster 

Ctrl+Left-click Increase 100 times faster. 

Ctrl+Shift+Left-click Increase 1,000 times faster 

  

Right-click Decrease the value (usually by 1). 

Shift+Right-click Decrease 10 times faster. 

Ctrl+Right-click Decrease 100 times faster. 

Ctrl+Shift+Right-click Decrease 1,000 times faster. 

  

Middle-click Set the minimum value (often 0). 

  

Notes: 

 

• In most cases, holding the mouse down will cause the value to change repeatedly 

until the button is released.  

 

• For many tables, clicking in the heading of a column will change all the values in 

the given column.   

 

• The word “click” by itself means a left-click. 

 

• Mouse-click means the entire set of mouse click actions in the table above is 

supported.  
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2 OMNI-200 Tutorial 
 

The CoreStar OMNI-200 tester has a very flexible configuration with numerous options 

that can be used to optimize the test for a wide variety of probes. The extensive set of 

options and settings can appear daunting, and the purpose of this tutorial is to provide a 

clear understanding of how to use them. 

2.1 Quick Start 

 

This section gives a quick overview of the steps needed to acquire data with the OMNI-

200. Later sections give more detailed explanations of each step. To acquire data with an 

eddy current probe: 

 

1. Connect the OMNI-200 power cord and make sure the POWER button is in the 

off position (the light on the switch will be off).  

 

2. Connect the OMNI-200 to your computer via an Ethernet cable. 

 

3. Connect an OMNI-200 ET pigtail to the EDDY CURRENT connector on the 

OMNI-200. 

 

4. Connect the probe to the Probe 1 connector on the pigtail. 

 

5. Turn on the power to the tester using the POWER switch. The switch should 

glow red and the cooling fans will startup.  

 

6. Boot the EddyVision Acquisition & Analysis software and click on the 

TESTER CONFIG button on the right side of the screen to display the OMNI-

200 configuration dialog.  

 

7. Configure network communication between the computer and OMNI-200. Use 

the TEST LINK button to verify that the tester and computer can communicate.  

 

8. Create or open a suitable tester configuration. 

 

9. Put the probe in a clean section of tubing and click BALANCE followed by REF 

NULL.  

 

10. Click Ok to save the configuration and return to the main acquisition screen. 

 

11. Acquire data.   

 

WARNING: Always power off the tester before changing pigtails. 
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2.2 Setup the Hardware 

 

Connect the power cord from the OMNI-200 into a standard power outlet. It supports 

both 120V and 240V and will auto switch between the two.  

 

Connect a Cat 5e or higher grade Ethernet cable between the OMNI-200 and your 

computer. You can either connect it directly to your PC or go through an Ethernet switch. 

You should not use a crossover cable when connecting to your PC.  

 

For eddy current, connect a CoreStar OMNI-200 ABS/DIFF pigtail to the EDDY 

CURRENT connector on the tester. Attach the probe itself to the PROBE COIL 1 

connector on the pigtail. If you are using a reference probe, connect it to the REF COIL 

2 connector on the pigtail.  

 

For RFT, use an OMNI-200 RFT pigtail and connect to the DRIVER/PICKUP 

connector on the OMNI-200. 

 

WARNING: You must use an OMNI-200 pigtail; OMNI-100 pigtails will not work. 

 

2.3 Software Setup 

 

Boot the CoreStar Acquisition & Analysis software. Change to a screen that is enabled 

for Acquisition (see EddyVision Acquisition & Analysis manual for details).  

 

A screen is enabled for acquisition using the Edit | Screens main menu option. Make 

sure Test is ON and Tester is OMNI-200 as shown below: 
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When this is done, click OK and the TESTER CONFIG button will be created in the 

acquisition panel on the right side of the main screen. Click it to display the OMNI-200 

configuration dialog.  

 

Since we wish to create a configuration from scratch, choose Edit | Clear Config to clear 

any configuration that may be currently open.  Also choose View | Number of Slots of 4 

and View | Slices Per Slot of 4. This configuration dialog will now look like this: 

 

 

Test must be ON 

Select OMNI-200 

for the Tester type. 
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2.4 Check Network Connectivity 

 

Now that the tester is physically connected and the EddyVision Acquisition software is 

running, we need to verify the Ethernet connection to the PC. The PC and OMNI-200 

communicate via Ethernet TCP/IP and UDP protocols. In order for this to work correctly, 

the IP (Internet Protocol) addresses of each must be setup correctly. 

 

Each piece of equipment (usually called a node) on the network, including your PC and 

the OMNI-200, has a unique physical address, called the MAC (Media Access Control). 

This is assigned by the vendor during manufacturing and cannot be changed by users. 

The MAC address of each OMNI-200 is shown on a label on the front panel. The MAC 

address has six segments called octets (e.g. 00:14:B3:00:00:4B). The first three octets of 

an OMNI-200 are always 00:14:B3.  

 

Each node also has a logical address, called its IP address, which can be set by the user. 

This address has four octets, such as 192.1.6.4. In order for your PC to successfully 

communicate with the OMNI-200, you must ensure: 

 

1. No two nodes on the network can have the same IP address. 

 

2. The IP address of the OMNI-200 is compatible with your network. 

 

3. The Acquisition software is using the correct IP address to communicate with the 

desired tester. 
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It is the user’s responsibility to ensure item 1 is true. To get started and troubleshoot 

networking problems, it is often best to connect the OMNI-200 directly to the PC so that 

these are the only two nodes on the network.  

 

For items 2 and 3, CoreStar has created a utility called IP Setup. Click IP Setup in the 

Util menu in the OMNI-200 dialog to display: 

 

 
 

The top table of the IP Setup tool shows all OMNI-200 testers on the current network 

whether they are compatible with it or not. In this case, there are two with IP addresses of 

192.1.6.42 and 192.1.6.43. These are the actual IP addresses of the testers. The MAC 

addresses displayed will match the MAC address label on the front panel of each tester. 

This can be used to pick a particular tester if there is more than one.  

 

The IP addresses of the computer are shown in the bottom table. In this case, there is only 

one of 192.1.6.4. Assuming these are the only nodes on the network, Item 1 above is 

satisfied in that each node has a unique IP address.  

  

WARNING: IP Setup only shows OMNI-200 testers and your computer. It is possible 

that other equipment on your network, such as another computer or 

network printer, could have a duplicate IP address that will cause 

conflicts. 
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However, note that the IP Address box in the upper right corner of the main OMNI-200 

configuration dialog is 192.1.6.45 as shown below: 

 

 
 

This is the address the software will attempt to use to communicate with the tester, but it 

does not match the address actually stored in any tester (as shown in the IP setup). The 

TEST LINK button can be used to test connectivity to the tester. At this point, clicking it 

will result in an error message in the status bar at the bottom of the dialog: 

 
 

To remedy the problem, you can either type in the address of a tester shown in the IP 

Setup (eg 192.1.6.42) or use IP Setup to change the tester’s actual address to 192.1.6.45.  

 

If we use the first option, so that the IP Address box looks like: 
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and click TEST LINK again, you will see a confirmation in the status bar that the link is 

good as shown below: 

 

 
 

This confirms that the software is successfully communicating with the tester.  

 

This method is not always possible since the tester IP addresses may not be compatible 

with the network. Whenever a tester’s IP address is not compatible with the network, the 

incompatible octets are highlighted in red as shown below: 

 

 
 

The reason for the incompatibility has to do with what is called a subnet mask. A detailed 

explanation of subnet masks is beyond the scope of this tutorial, but a few examples will 

suffice for our needs. Notice that the subnet mask of the computer is 255.255.255.0. This 

means that the first 3 octets of the IP address of all equipment on the network must be the 
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same. But the first three octets of the computer’s address are 192.1.6 and those of the 

testers are 192.1.7. The third octets are not the same (i.e. the computer is 6 and the tester 

is 7).  

 

There are several ways to remedy the problem. 

 

2.4.1 SOLUTION 1: Modify the Testers IP Address (Recommended) 

 

If wish to talk with say the first tester in the list, the simplest solution in this case is to 

change the 7 to a 6: 

 

 
 

Notice that the third octet is no longer red since there is no conflict, but the SET column 

shows NO. This means that the displayed IP address for tester 1 has not actually been 

stored in the tester. To do so, click on the NO to get: 
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Clicking OK will set the IP address of tester 1 in the IP Address box. Click TEST 

LINK to verify that the link is good.  

2.4.2 SOLUTION 2: Modify the Computers Subnet Mask 

 

Instead of changing the IP address of tester 1 from 192.1.7.42 to 192.1.6.42, another 

option would be to change the subnet mask of the PC. This can be done using the 

Microsoft Windows network tools. If it is changed to 255.255.0.0, then only the first two 

octets of the IP addresses must match.  

 

On Windows XP, this can be done by: 

 

1. Select Network Connections from the Control Panel. 

 

2. Select Local Area Connection from the list of Network Connections.  

 

3. Click Properties button in the Local Area Connections Status dialog.  

 

4. Click on Internet Protocol (TCP/IP) in the table of protocols and then 

Properties 
 

5. Enter the desired Subnet Mask of 255.255.0.0 
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At this point, an IP address of 192.1.7.42 for tester 1 and 192.1.6.4 for the computer are 

compatible as shown below: 

 

 
 

 

2.4.3 SOLUTION 3: Modify the Computers IP Address 

 

A third option would be to change the computers IP address to say 192.1.7.4, so that its 

IP address is compatible with the testers. This is usually not a good idea since your 

network administrator may want your network setup in a certain way. 

 

2.4.4 SOLUTION 4: Use DHCP or BOOTP 

 

Another solution is to use DHCP (Dynamic Host Control Protocol). This is rarely used by 

most users, but can be useful. It requires a DHCP server on your network. Your DHCP 

server must be configured with the MAC address of all testers you wish to use, along 

with the IP address you wish to assign to the tester. Put this IP address in the IP Address 

box of the OMNI-200 configuration dialog.  
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You must also configure your computer to be in DHCP mode. The person administering 

your DHCP server can tell you how to do this.  

 

Whenever you power on the OMNI-200 tester, it will send out a BOOTP request, which 

is compatible with DHCP, and if the DHCP server has its MAC address, it will respond 

with the desired IP address. The tester will use this address instead of the one stored in it.  

 

Whenever your computer is in DHCP mode,  IP Setup will be blank as shown below: 

 

 
 

 

If this is the case, and you do not with to use DHCP, you must disable DHCP mode (see 

Disabling DHCP on Your Computer on page 96. 
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2.5 Create Configuration 

 

We will start with explaining how to configure a common bobbin probe. We will use a 

CoreStar CA-460/UBF/MF/BC probe which is 0.460 inches in diameter. The internal 

reference feature will be used so that no reference probe is required. The material to be 

inspected is 5/8 inch OD, 0.058 wall thickness, 304 stainless steel. We will use an AS-

015-07 standard which has an ID groove, OD groove, 20%, 40%, 60% 80%, and 100% 

defects.  

 

After Edit | Clear Config, the OMNI-200 configuration will appear as follows: 

 

 
 

2.5.1 Setting the Sample Rate 

 

The first step is to set the desired Sample Rate and Trigger mode in the upper left part 

of the screen:  
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The Trigger mode should almost always be set to Internal. In this mode, samples will be 

taken at the rate shown in the Sample Rate box. The other Trigger modes are for 

advanced applications that trigger based on an external encoder or trigger signal.  

 

The Sample Rate is typically chosen to provide at least 30 samples per inch for the 

desired probe speed. Using higher values allows for higher probe speeds, but reduces the 

amount of time per sample. In this case, we will use 1000 samples per second.  

 

2.5.2 Selecting the Test Coils 

 

Click on a coil box to select the desired test channels. We are using a bobbin probe and 

the CoreStar AM-201 probe module. This module uses coils 1 and 2 for the differential 

and absolute channels.  
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The enabled channels show up in red since we have not yet chosen a frequency. Anytime 

something in the OMNI-200 configuration is in red, it indicates an error or something 

that is not complete. To see a description of the error, click the EXPLAIN button.  

 

2.5.3 Setting up the Test Frequencies 

 

Next we need to decide on the set of test frequencies. This document is not intended to 

explain eddy current theory, so we will just outline how the frequencies would typically 

be chosen, and then explain how to set them. 

 

Whenever the magnetic field of the probe encounters a conductive material, the 

amplitude of the signal will be increasingly attenuated the farther it penetrates. The 

equation that defines when the signal will be 1/e (where e = 2.718) times its value at the 

surface is: 

 

ff

ρ

µπ

ρ
δ 29.503

0

≈=  

 

where: 

 

mH /104 7

0

−×= πµ  is the magnetic permeability of free space 

Click in a cell to 
create an eddy 
current channel for 
the given frequency 
and coil.  
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=ρ  the resistivity of the material in mΩ  

=f  the frequency in Hz 

 

Solving for the frequency in terms of skin depth gives: 

 

2

510533.2
δ

ρ
×=f  

 

The resistivity of 304SS is mΩ× −810970.68  and the wall thickness is 0.058 inches or 

m
31047.1 −× . So the frequency at which the wall thickness is one skin depth is: 

 

Khzf 8.80
)1047.1(

10970.68
10533.2

23

8
5 =

×

×
×=

−

−

 

 

A rule of thumb is to use 2 or 3 times this frequency for the highest inspection frequency, 

so we will use 200 KHz. We will use additional frequencies of 150 KHz, 100 KHz, and 

25 KHz.  

 

Mouse-click to adjust the frequencies: 

 

  

 
 

 

Mouse-click in the 
FREQUENCY column to 
change the frequency. 
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HINT: • Click to the left of the decimal point to change the integral part of 

the frequency, and to the right of it to change the decimal part. 

 

• Hold down the Shift key to change 10 times faster.  

 

• Hold down the Shift key to change 100 times faster. 

 

• Click the middle button to set to zero.  

 

Note that the coils now show a number. This is the eddy current channel number that will 

appear in the Acquisition & Analysis software. They are shown in yellow because we 

have not yet set the coil type. 

 

 
  

Set coil 1 to DIFF and coil 2 to ABS. It will now look like: 

 

Right-click in the COIL 
number to display the 
coil mode menu. 
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2.5.4 Setting Drive Voltage 

 

The drive voltage of the OMNI-200 varies from 0 Vpp to 20 Vpp. In the OMNI-200, this 

is expressed as a percentage of full-scale with a default of 75% (i.e. 15 Vpp). To adjust it, 

mouse-click in the DRIVE field.  

 

Normally, higher drive voltages improve the signal to noise ratio, but if saturation occurs, 

it may be necessary to reduce it. For this example, we will set them all to 100%.  
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HINT: • The simplest way to get to 100% drive it to middle-click to get to 

0% and then right-click to get to 100%. 

 

• To change all drive values at once, click in the DRIVE title area. 

  

 

 

2.5.5 Set Coil Input Gains 

 

The coil input gain is the final gain stage prior to analog to digital conversion in the 

OMNI-200. Its value ranges from -22 dB to 20 dB.   

 

When dynamic gain is ON, the actual gain value for a given sample may be stepped 

down from this value to avoid saturation. If 32-bit Mode and Dynamic Gain are ON, it 

is usually possible to simply use the maximum gain of 20 dB. In 16-bit mode, it may be 

necessary to lower the value to avoid saturation.   

 

To change a given gain value, click on the gain value for the given slot and coil. To 

change all the gains for a given coil, click on the coil numbers as shown below: 

 

 

Mouse-click in the DRIVE 
column to change the 
drive voltage for a single 
time slice. 

Click in the DRIVE 
column title to change 
all time slices at once. 
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For this example, left-click on the titles of coils 1 and 2 to set all gains to 20 dB as below: 

 

 
 

Mouse-click in the COIL 
number to modify the gains 
for all time slots at once.  
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2.5.6 Setting Delays 

 

The delay table allows the user to set the delay between the time the sine wave to the 

probe is turned on and the time when the actual demodulation of the signal begins. This 

time is to allow the wave to settle in the tube material.  

 

 

 
 

The default value for delay is 50 µs, which is usually sufficient, but not optimum. The 

optimum value is one that delays the demodulation until transients have settled. The 

OMNI-200 scope feature provides a way of determining this.  
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Click on the Scope tab and adjust the display parameters until you can see the wave: 

 

 
 

The scope shows that a value of 10 µs is sufficient to skip over the transient. You should 

look at each slot since the value may vary with frequency. You do not want to set the 

delay any larger than necessary since that will reduce the amount of time available for 

demodulating the signal. A conservative value in this case is 20 µs as shown below: 

 

 
 

2.5.7 Setting Integrations 

 

Click TESTER ON to 
enable the Scope chart. 

Click these fields to 
adjust the display. 

Drag the horizontal 
cursors to see where the 
signal has settled. 

Transient when wave is 
turned on for time slot 1. 

Drag vertical cursor to 
measure the transient. 
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The delay table is also used to set the number of waves used to demodulate each time 

slot. Using more waves increases the signal to noise ratio, but also consumes more time. 

The total amount of time available is limited by the Sample Rate. This, along with the 

amount of time used by the current configuration, is shown in the lower left part of the 

status bar: 

 

 
 

Mouse-click in the INTEG field in order to adjust the waves. A good starting point is to 

adjust the number of waves in each slot so that each uses about the same amount of time. 

Since the total amount of time available is 1000 µs, this is around 250 µs: 

 

 
 

This is usually not optimum, which is why the OMNI-200 allows you to adjust it. For 

example, the 25 KHz is often nothing but a locator channel so we will set it back to 2 

waves. This frees up time to add waves to other slots. The 200 KHz and 150 KHz are our 

prime analysis frequencies, so we will increase them as much as possible: 

 

  
 

At this point, the status bar shows we have used 1000 µs out of 1000 µs and we cannot 

add any more integrations. If we attempt to do so, errors will be shown in red: 

Adjust the values in the INTEG 
column to roughly equalize the 
values in the TIME column. 
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To see the cause of the errors, click the EXPLAIN button to see: 

 

 
 

Along with the source of the error, the EXPLAIN dialog usually says how to correct the 

situation.  

 

2.5.8 Setting Coil Parameters 

 

The final table we must setup is the coil parameters: 
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They TYP column is already set since we already configured the coil types. Click on the 

BC (Balance Coil) column for coil 1 to enable coil balancing on the differential channel. 

Only coils with BC enabled will be balanced.  

 

2.5.9 Setting Options 

2.5.9.1 Config Options 

 

The recommended Config Options are shown below: 
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We will be running in multiplex mode, so Continuous Mode is OFF. In Continuous 

Mode, there is only one time slot and all frequencies are excited at the same time. The 

advantage of this is it allows higher sampling rates and avoids transients. However, it also 

limits the output drive voltage of each frequency as well as the allowable choices of 

frequency. It is primarily needed for very low frequency tests. 

 

In 32-bit Mode, each X and Y value is 32-bits; otherwise it is 16-bits. Using 32-bit 

Mode will double the size of the data file, but disk space is cheap and we recommend it 

to help avoid saturation.  

 

Dynamic Gain is a feature of the OMNI-200 that allows it to scale down the probe inputs 

in order to avoid saturation. The OMNI-200 uses 14-bit ADC, but the dynamic gain 

feature makes it effectively a 21-bit tester. To fully take advantage of this, you must use 

32-bit Mode since in 16-bit mode the upper 5 bits will be truncated. We recommend that 

you always run with Dynamic Gain ON. 

 

Internal Reference avoids the need for a physical reference probe. The absolute signals 

will be somewhat noisier than those of a physical reference probe. This can usually be 

handled by adding some filters in the analysis software, but if this is an issue, turn this 

OFF and connect a reference probe to the Probe 2 connector on the pigtail.  

 

Internal Reference only supports one absolute coil.  

 

We recommend turning Time Slew ON since it improves the quality of mixes. 

 

Increment Caps, Auto Stop, and Synch Output On should always be OFF.   

 

No Powerdown should always be ON. 

 

2.5.9.2 Probe Options 

 

These are options that only apply to special probes. If you are not using such a probe, 

leave the options OFF.  
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2.5.9.3 AUX Chans 

 

The AUX Chans should normally be left OFF.  

 

 
 

 

2.6 Using the Configuration 

 

We have now created the complete configuration shown below: 
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To use it, place the probe in a clean section of tubing and click BALANCE.  The 

progress of the balance will be displayed in the status bar. Once complete, the value of 

the caps chosen will be shown in the CAP column of the coil table: 

 

 
 

Note that only coils with the BC column enabled are balanced. 

 

For a good probe, this value should be fairly small. If it is in the hundreds, it means the 

two coils are severely out of balance.  

 

Since we are using Internal Reference, click REF NULL. This is complete when 

“Done” appears in the status bar.  
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Now choose Save As from the File menu and save the configuration to a file. We have 

used tutorial.cfg. Click Ok to get back to the main acquisition screen. Click the TESTER 

OFF button to acquire data: 
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2.7 Sample Configurations 

 

2.7.1 High Frequency with External Reference 

 

 
 

Notes: 

 

1. Use the View menu to select Number of Slots of 4 and Slices per Slot of 1.  

 

2. The Internal Reference option is OFF and the REF NULL button is disabled. 

 

3. Since Internal Reference is not being used, it makes sense to balance the ABS 

coil. 
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2.7.2 High Frequency with Internal Reference 

 

 
 

Notes: 

 

1. The only difference between this configuration and the previous one is that 

Internal Reference has been turned ON. 

 

2. Since Internal Reference is ON, you must perform REF NULL after doing the 

BALANCE. 

 

3. The ABS coil is not balanced with Internal Reference ON.  
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2.7.3 Low Frequency with External Reference 
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2.7.4 Low Frequency with Simultaneous Injection 

 

 
 

Notes: 

 

1. In the View menu, select Number of Slots of 1 and Slices per Slot of 4. 

 

2. Since there is only one time slot, turn on Continuous Mode. 

 

3. In Continuous Mode, the delay is set to the lowest value.  

 

4. Each of the four frequencies has a drive of 29% which would seem to add up to 

116%. This is possible since the peaks of the various frequencies occur at 

different times. Click on the Waveform tab to see that the composite waveform 

does not exceed 100% at any point.  
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2.7.5 Low Frequency RFT 

 

 
 

Notes: 

 

1. RFT uses coils 5 through 8. 

 

2. Use DRIVER 3 for RFT. 

 

3. The units of frequency have been changed to Hz instead of KHz. So the frequency 

in this sample is 300 Hz.  

 

4. RFT has an additional gain stage ranging from 1 to 730. In this case, it is set to 

98. 

 

 

 

RFT drive 
gain is used. 

RFT uses drive 3. RFT uses coils 
5 through 8. 

Frequency 

units are Hz. 

Continuous mode is 

used and delay is set to 

the minimum.  
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2.7.6 High Frequency RFT 
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3 Tester Configuration Dialog 
 

The main OMNI-200 configuration screen is shown below. The exact appearance will 

depend upon options selected in the View menu. The one shown is for a typical bobbin 

probe configuration. 

 

 
 

Menu Bar Tool Bar Caption Main 
Configuration 

Delay 
Table 

Gain 
Table 

Coil 
Config
Table 

Options 

Status Bar Time Used OK and Cancel 
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3.1 Caption 

 

The caption at the top of  dialog shows the current configuration file. 

 

 
 

Dialog Name Shows that this is the OMNI-200 configuration tool. 

Probe Number EddyVision acquisition can support up to four probes, each 

using an independent OMNI-200 tester.  

File Name Shows the currently loaded configuration file. This will be 

blank for a new configuration. If the file is located in the 

tester_configs\OMNI-200\ directory of the current 

project, only the file name is shown. Otherwise, the full path of 

the file is shown. 

Help Clicking the  will cause help information to be displayed 

whenever the cursor hovers over an area of the screen. 

Cancl Clicking  the   has the same effect as the CANCEL button. 

Help 
Probe 
Number 

Dialog Name File Name Cancel 
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3.2 Menus 

 

This section describes the menu commands found at the top of the configuration dialog. 

 

 
 

 

3.2.1 File Menu 

 

 
 

 

 

Open … Load a tester configuration that has been saved to a file. The 

initial directory will be tester_configs\OMNI-200\ of 

the current project.  

Save Save the current tester cofiguration to the file name shown in 

the caption.  

Save As … Save the current configuration to a new file. 

Import … Load a tester configuration that has been saved to the central 

user directory for use in multiple projects. This will typically be 
C:\Program Files\CoreStar\EddyVision 

6.4\user\tester_configs\OMNI-200 

Export … Export to the common user directory. 
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Print Screen … Print a screen capture of the current configuration. 

Print Config Displays a plain text version of the configuration in a text editor 

which the user can then save or print.  

 

 

3.2.2 Edit Menu 

 

 
 

 

Undo Nullify a recent configuration action. If you have not performed 

and action that can be undone, this item is grayed out. 

Otherwise, it will show the most recent action that can be 

undone. After undoing an action, the next action that can be 

undone will be displayed. 

Clear Config Clear the configuration to a default state. 

 

 

3.2.3 View Menu 

 

The View has options to customize the tester configuration display.  When an option is 

active, a check mark will be displayed beside it.  
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Show Modulation Show the overall modulation frequency of the OMNI-200 

driver outputs. This is not used by any standard probe and 

should be unchecked.  

Phase Offset Show a PHASE column in the main configuration table which 

represents the phase offset of that time slice.  

Compensator Show PHASE and GAIN columns in the main configuration 

table which represent the phase and gain of the compensator 

driver used for internal reference. Although they can be 

manually adjusted, these are normally for information purposes 

only and need not be displayed. 

Raw Status Values This will display the raw measurements used to compute 

temperature and voltages in the Status tab. These are not 

normally needed by end users and this option should be off.  

Number of Slots Used to select the total number of timeslots displayed. 

Slices Per Slot Used to select the number of frequency slices in each time slot. 

Show All Used to turn on all viewing options and display the maximum 

number of slots and slices. 

 

 

3.2.4 Probe Menu 

 

These commands create a default configuration for certain probes. This can be used as a 

starting point. Each of these commands will add an entry to the Edit | Undo menu. 

 

 
 

Bobbin Sets a default configuration for a typical bobbin probe. 

MHI I-Probe Sets a default configuration for the MHI Intelligent Probe.  

 

 

3.2.5 Tools Menu 
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The Tools menu is used to display menus that show detailed information about the 

current configuration. These are rarely needed by users. 

 

 
 

Gain Cal … Opens the Gain Calibration tool which enabled you to view and 

print information about the gain calibration stored in the tester. 

For more information see Gain Calibration Tool on page 88. 

Hardware Null … Opens the Hardware Null tool which enables you to view the 

offsets used by the hardware null. For more information, see 

Hardware Null Tool on page 91. 

 

 

3.2.6 Util Menu 

 

This menu has various commands used to view detailed information about the tester 

configuration and configure the networking. Only the IP Setup utilitiy is commonly 

used. 

 

 
 

 

IP Setup Shows the IP Setup tool which allows the user to configure the 

network. See IP Setup Utility on page 93 . 

Export Bits … Export the current tester configuration as a special “bits” file 

used by certain third party software. 

View Virtex Config Show the current tester configuration in plain text form in a text 

editor. 
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View Memory Map Show the contents of the testers processor memory map in a 

text editor. 

View Memory Show a hex dump of the contents of the testers working 

memory.  
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3.3 Toolbar 

 

The toolbar contains a number of buttons to quickly access certain commands regardless 

of which tab is currently displayed.  

 

3.3.1 Toolbar Left 

 

 
 

TEST LINK Test the network link between the software and the tester. If 

successful, a “Link Good” message will be displayed in the 

status bar. If an error is displayed, see the troubleshooting 

section ???. 

TESTER ON Turns on the tester. This is used for certain actions such as the 

Scope tab.  

EXPLAIN If any fields are displayed in red, which indicates an error, click 

the button to see an explanation and possible remedy.  

BALANCE Balances the probe coils (see section 3.3.1.1 ). 

REF NULL Compute and store the internal reference signal (see section 

3.3.1.2). 

HW NULL Compute and store the hardware null (see section 3.3.1.3). 

 

When performing the BALANCE, REF NULL, and HW NULL operations, they should 

be done in order from left to right.  

 

3.3.1.1 Balance Probe Coils 

 

The OMNI-200 can apply capacitance to either the A or B probe coil on order to balance 

the impedance of the two sides. To balance the coils: 

 

1. Place the probe in a clean section of tubing. 

 

2. Select the coils to balance in the Coil Config table by clicing the BC column for 

the appropriate coils. Selected coils are colored green. 
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3. Press the BALANCE button in the toolbar.  

 

The progress of the balance operation is displayed in the status bar. It will display 

“Balance Done” when complete and the results will be displayed in the CAP column of 

the Coil Config table (see Coil Config Table on page 62). The value is in picoFarads.  

 

A good balance value should be relatively low. A high value in the hundreds of pF man 

indicate a defective or malfunctioning probe.  

3.3.1.2 Generate Internal Reference 

 

The OMNI-200 has the ability to replace a physical external reference probe with a 

virtual reference. The tester generates a signal that is equivalent to the one produced by a 

physical reference. To generate this signal: 

 

1. Make sure that Internal Reference is enabled in the Config Options.  

 

2. Select one coil to be the absolute coil. Do this either by clicking on the TYP 

column for the given coil in the Coil Config table or by right clicking on the coil 

number in the COIL column of the Main Config table. In both cases, select ABS 

for the coil type.  

 

3. Place the probe in a clean section of tubing. 

 

4. Click REF NULL in the toolbar.  

 

The progress of the operation is displayed in the status bar. It will show “Done” when 

completed and the computed values will be displayed in the COMPENSATOR columns 

of the Main Config table (these are only visible if the View | Compensator menu item is 

checked.  

 

The quality of the internal reference can be viewed by selecting the absolute coil in the 

Scope tab (see Scope Tab on page 68).  

3.3.1.3 Generate Hardware Null 

 

The OMNI-200 can add a digital offset to the data to center it around zero. This is usually 

only required for certain analysis systems that use the absolute voltage values instead of 

relative voltages. It has no effect on standard measurements, such as volts peak-to-peak. 

 

It can also be useful for poorly balanced probes in 16-bit mode. Internally, the OMNI-200 

always operates in 32-bit mode; truncation to 16-bit data only occurs at the very end prior 

to sending it to the PC. If the overall signal size is within the 16-bit range, but it so far 

offset that parts of it will be truncated, it may be helpful to center it around zero first.  

 

To generate the hardware null: 
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1. Place the probe in a clean section of tubing. 

 

2. Select the coils to null in the Coil Config table by clicking on the HN column.  

 

3. Click on HW NULL in the toolbar.  

 

The hardware null values are generated and stored in the tester. They may be viewed 

using the Tools | Hardware Null menu. 

 

3.3.2 Toolbar Right 

 

 
 

ABORT Perform a warm reboot of the tester. This is not needed by most 

users.  

POWER DOWN Power down the analog portions of the tester. This is not needed 

by most users.  

IP Address This field shows the IP address of the tester the software will 

attempt to connect to. For more information, see IP Setup 

Utility on page 93.  
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3.4 Config Tab 

 

The Config tab is the main tab of the tester configuration window and contains most of 

the options you will need. 

 

3.4.1 Fields Left 

 

The upper left side of the Config tab displays the following fields: 

 

 
 

If Trigger is set to Encoder, two additional fields are displayed as shown below: 

 

 
 

Sample Rate When using an internal trigger, this is the number of eddy 

current samples acquired each second. This defines the time 

duration of each sample which is displayed in the Time Used 

display to the left of the Status Bar at the bottom of the 

window. 

 

When not using an internal trigger, this can be used to define 

the maximum number of samples per second (see Trigger 

below). Adjust it so that the Time Used is as large as possible. 

This will determine the maximum sample rate for the external 

trigger or encoder.  

 

If the Time Used is less than the time available, the maximum 

sample rate for Trigger modes other than Internal can be 

determined by taking the inverse of the Time Used (so long as 

nothing is in red). For example, if the Time Used is 800 µs, the 

maximum sample rate is: 

 

250,1
10800

11
6

===
−

xt
SR

used

MAX   

Num Chan A read-only field showing the total number of eddy current 

channels. This is equal to the number of active blocks in the 

COIL columns of the Main Config table. 
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Trigger Determines what will cause a sample to be acquired: 

 

Internal Samples will taken at the rate shown in the 

Sample Rate field.  

External The tester samples each time the external 

trigger input goes high. If the trigger rate 

exceeds the maximum sample rate, some 

triggers will be ignored and errors will be 

generated. These can be viewed in the 

Trigger Errors field of the Status tab. 

Encoder The tester samples based on an encoder 

input. The triggers per second should not 

exceed the maximum sample rate or some 

will be ignored and errors generated. These 

can be viewed in the Trigger Errors field of 

the Status tab. 
 

Enc Num (Only visible if Trigger is set to Encoder). Defines which 

encoder is used as the trigger.  

Enc Inc (Only visible if Trigger is set to Encoder). Encoder triggers 

occur at multiples of this increment.  

 

 

3.4.2 Fields Right 

 

The upper right side of the Config tab displays the Modulation field: 

 

 
 

This is only visible if View | Modulation is checked. For normal operation, this value 

should be zero.  

3.4.3 Config Options 

 

These options control how the tester generates signals and collects data: 
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ON The tester is in simultaneous mode where the 

output drive is left on at all times. Advantages 

include: 

 

1. This eliminates transients that result when 

the drive is turned on and off as it is in 

“multiplex mode”. At high frequencies, 

this is usually not important since delays 

can be set high enough to bypass the 

transient. 

 

2. At low frequencies, this also allows for 

higher sampling rates since there may not 

be enough time for multiplexing.   

 

3. The quality of mixes may be improved 

since all frequencies are sampled at the 

same time, and thus at the sample position 

in the tube. Enabling the Time Slew option 

can achieve the same effect in multiplex 

mode. 

 

However, only one time slot is available and the 

drive output for each simultaneous frequency is 

limited since the total cannot exceed 100%. The 

choice of simultaneous frequencies is also limited 

since they must be compatible with each other.  

Continuous Mode 

OFF The tester is in “multiplex” mode. For each 

sample, the output drive is turned on at the start of 

each time slot and off at the end. This generates 

transients, however, the limitations mentioned 

above are avoided.  
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ON Raw x,y data is collected with 32-bit resolution. 

The advantage is that saturation is much less 

likely, even at tube ends. The disadvantages is that 

data files will be twice as large. This is the 

recommended setting when using CoreStar 

analysis. 

32-bit Mode 

OFF Raw x, y data is collected with 16-bit resolution. 

ON Input gain settings are automatically adjusted for 

each sample to avoid signal saturation of the ADC. 

The output drive to the probe is not modified in 

any way. This is the recommended setting. 

Dynamic Gain 

OFF Input gain settings remain constant at all times.  

 

For more information, see Config Options on 

page 25 .  

ON Use the OMNI-200 internal reference. The 

advantage is that no physical reference probe is 

required, however the absolute channels may be 

somewhat noisy. See Config Options on page 25 

for more information. 

Internal Reference 

OFF Use an external reference probe for absolute 

channels.  

ON Data is linearly interpolated so that all channels 

are effectively sampled at the same time as time 

slot 1. This can greatly improve the quality of 

mixes and is the recommended setting whenever 

the probe speed is reasonably constant or sampling 

is triggered by an encoder.  

Time Slew 

OFF Data is not interpolated.  

ON This setting is only used during manufacturing and 

testing.  
Increment Caps 

OFF Always set to Off. 

Auto Stop ON This setting is only used during manufacturing and 

internal purposes. 
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OFF Always set to Off.  

ON Analog parts of the tester always remain powered 

on even when the tester is not acquiring data. This 

is the recommended setting. 

No Powerdown 

OFF Analog parts of the tester will power down when it 

is not acquiring data.  

ON A synchronization output pulse is generated at the 

start of each sample. This signal is available on pin 

on the Remote I/O connector on the front panel of 

the tester. This is commonly used as the external 

trigger input of a second tester.  

Synch Outputs On 

OFF No synchronization pulse is generated.  

 

 

3.4.4 Probe Options 

 

 
 

ON Turn on when using a Ghent probe. Ghent On 

OFF Turn off for any other type of probe. 

ON Turn on if you are using a high-speed RPC motor 

unit. 
High Speed RPC 

OFF Turn off for non-RPC probes or regular motor 

units. 



3 Tester Configuration Dialog Core Star 
 

  
OMNI-200 Reference Manual (Rev 6.5) 51 of 101 

 

ON Turn on when using address-based array probes 

such as the MHI I-Probe. 
Array Outputs On 

OFF Turn of otherwise. 

ON Turn on if using an X-Probe. X-Probe Clock On 

OFF Turn off otherwise. 

ON Turn on if using NEL Smart probe. Smart Probe 

OFF Turn off otherwise. 

 

 

3.4.5 AUX Chans 

 

This panel is used to enable optional channels. The values of these channels can be 

viewed in the balance dialog in the main acquisition/analysis screen.  

 

 
 

Time Includes a 64-bit time value for each sample. It is 

the time in nanoseconds since the tester was turned 

on. This mostly useful when not using internal 

trigger mode. 

Encoders Enables encoder channels (see Delay Table on 

page 58). 

RMS Includes the averages and root-mean-square 

(RMS) value of the ADC inputs for each coil 

during the demodulation process. 
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Gains Includes the gain values for each dynamic gain 

amplifier for the given sample. The data can be 

color coded by enabling Color Code Gains in the 

OPTIONS dialog.  

Sample Index Include a 32-bit sequential sequence number, 

starting at 0, with each sample. This can be used to 

verify that no samples are missed. EddyVision32 

acquisition will display an error message if there is 

such an error. 

Status & IO This option includes a 4-byte channel for each 

time slot of each sample. The bytes are defined as 

follows: 

 

BYTE 

OFFSET 
NAME DESCRIPTION 

0 overflow Bit n = 1 if the ADC 

for coil n was 

saturated at any time 

during the 

demodulation. 

Bit 0 1 if the 

FPGA FIFO 

overflowed 

since the 

tester was 

last turned 

on. The 

number of 

errors can be 

seen in the 

Status tab. 

1 errors 

Bits 

0-7 

reserved 

2 inputs Bit n is the state of 

AUX input n at the 

start of the time slot. 
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3 outputs Bit n is the state of 

AUX output n at the 

start of the time slot. 

 

Sample Flags A 4-byte channel that includes the following 

information: 

 

BYTE BIT DESC 

0 1 if a probe is attached, 0 

otherwise. 

1 1 if a probe has been changed. 

2 1 if alarm asserted 

0 

3:7 reserved  

0:3 Profile segment address. This is 

used for tester-in-pusher systems 

only and is driven by the Galil 

motor controller in the pusher. 

1 

4:7 reserved 

2 0:7 reserved 

3 0:7 reserved  
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3.4.6 Main Configuration Table 

 

The Main Config table is used to enter frequencies, drive strengths, and configure the 

channels. 

 

 
 

The exact appearance will depend upon the View menu settings (see View Menu on page 

39). The example above is configured for 4 time slots, 4 slices per slot, and view 

compensator on. The columns are defined as follows: 
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TIME SLOT In multiplex mode, each sample is divided into time slots (the 

maximum is 16). Each time slot is divided into up to 4 time slices, 

each with its own frequency. The frequencies within a time slot are 

simultaneously injected into the probe.  

 

Right-click on a time slot cell to popup a menu to perform certain 

operations: 

 

 
 

Replicate Up Copy the current time slot settings to 

all slots above it in the table. 

Replicate Down Copy the current time slot settings to 

all slots below it in the table. 

Clear Clears all settings. 

 

All of these actions can be undone using the Edit | Undo 

command. 

DRIVE # The output driver used to generate the signals for that time slice. 

Mouse-click in the cell to change the value. Only drivers 1 and 3 

are available for end-users. Drivers 2 and 4 are used to create 

absolute reference signals.  

DRIVER 

FREQUENCY 

The frequency that is output by the given driver for this time slice 

during this time slot. The actual wave form produced during that 

time slot for the given driver is the sum of all the time slices and 

can be viewed in the Waveform tab.  

 

The frequency can be changed via standard mouse clicks. If you 

click to the left of the decimal point, it will change the integral part 

of the frequency while clicking to the right will change the 



3 Tester Configuration Dialog Core Star 
 

  
OMNI-200 Reference Manual (Rev 6.5) 56 of 101 

 

fractional part. 

 

Clicking on the units will change the units to Hz, KHz, or MHz. 

 

All of the frequencies in a given time slot must be compatible. The 

fundamental frequency is the lowest frequency in that slot divided 

by the number of waves specified in the INTEG (wave) column of 

the Delay table (see Delay Table on page 58). All frequencies 

must be an integral multiple of the fundamental. If they are not, the 

incompatible frequencies are displayed in red and the EXPLAIN 

button can be used to show the reason.  

DRIVER PHASE The phase offset of the wave for this time slice. This column is 

only visible if View | Phase Offset is checked.  

 

These values are typically left at zero, but with simultaneous 

injection, it may be possible to increase the available driver gain 

beyond 100% by adjusting the phase of certain components.  

DRIVER DRIVE The actual drive voltage as a percent of the maximum. The total 

drive must not exceed 100% of the drivers maximum output. 

However, this does not necessarily mean that the sum of the driver 

values for the given slot must be less than or equal to 100%. By 

adjusting the phase offsets, it is often possible to get slightly more 

gain for certain components.  

COMPENSATOR 

PHASE 

This is the phase offset used by the compensator to create the 

absolute reference.  

 

The values in the COMPENSATOR PHASE and GAIN columns 

are computed when the REF NULL button is clicked (see Toolbar 

Left on page 43).  These values are editable to optimize the 

absolute channels, but this is usually not required. 

COMPENSATOR 

DRIVE 

This is the drive value used by the compensator to create the 

absolute reference.  

COIL  

1 to 8 

Each of the eight columns corresponds to an OMNI-200 input coil. 

Click a cell to create an eddy current channel for that coil during 

that time slice. The number in the cell corresponds to the eddy 

current channel number shown in the acquisition & analysis 

software. 

 

Right-click in a coil number to display a menu used to select the 

type of coil: 
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When using Internal Reference, it is important that the absolute 

coil is properly configured.  

 

Left-click in a coil number to turn all cells in that column on or off. 

 

If you have not specified a nonzero frequency, the cell will be 

displayed in red. If you have not specified the type of coil, it will 

be shown in yellow.  
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3.4.7 Delay Table 

 

Use the Delay table to optimize time usage during data acquisition.   

 

 
 

It has the following columns: 

 

SLOT The time slot of this row of the table. The number of rows matches 

the number of time slots chosen in the View | Number of Slots 

menu. 

DELAY (µs) The time, in µs, to wait after the driver is turned on for this time 

slot and to when the demodulation begins. In multiplex mode, this 

allows time for the wave to settle in the tube. In continuous mode, 

the output is always left on an this value can be set to the minimum 

of 1.  

 

You can use the Scope tab, which shows the actual probe signal, to 
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determine how much time is required (see Scope Tab on page 68). 

INTEG  (wave) The number of waves over which demodulation is  performed 

during that slot. Higher numbers yield cleaner data due to noise 

averaging, but reduce the maximum sample rate and reduce the 

bandwidth. 

TIME (µs) A read-only field that shows the total duration of the time slot. It 

includes the delay, demodulation, and overhead time. If the total 

time available has been exceeded, this column will be red.  

ENCODER 1 to 5 If encoders are enabled in the AUX Chans section, these cells 

indicate which encoders are active during each time slot. Click on a 

cell to activate it. Active encoders are shown in green. Click on an 

active encoder to deactivate it.  

 

If encoders have not been enabled in the AUX Chans section, cells 

will be colored red.  

 

Clicking in the heading of a column modified all cells in the column. 
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3.4.8 Coil Input Gain Table 

 

Use this table to set the input amplification for each coil. It is desirable to set the gain as 

large as possible to improve signal to noise. However, too high a value may cause some 

signals to saturate.  

 

If Dynamic Gain is off (which is not recommended), the gain values are fixed at the 

values shown in the table. If Dynamic Gain is on, the values are the maximum values. 

For each sample, the tester examines the size of the signal coming into the ADC and 

steps the gain down as required in order to avoid saturation. A multiplication factor is 

applied to the final x, y value to scale it back up so that all samples are effectively at the 

same gain value. These numbers come from the gain calibration tables stored in the tester 

during manufacturing (see Gain Calibration Tool on page 88).  

 

Internally, the OMNI-200 processes all signals as 32-bit data. However, some third party 

programs require 16-bit data. In 16-bit mode, the 32-bit x, y values are limited to the 

signed 16-bit range. Thus, even with Dynamic Gain on, it is possible to have saturated 

signals and it may be necessary to limit the maximum gain. But in 32-bit mode with 

Dynamic Gain on, it is almost impossible to saturate and we recommend setting the 

gains to the maximum.  
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Mouse-click in the cell for a given slot and coil to change the gain. Mouse-click in the 

column heading to change the gain for the given coil for all time slots at once. 

 

The recommended rules of thumb for the coil input gain are: 

 

1. Always use Dynamic Gain. 

 

2. Use 32-bit mode when using EddyVision Acquisition & Analysis and set the 

gains to the maximum value. 
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3.4.9 Coil Config Table 

 

Use this table to configure various options for each coil. 

 

 
 

COIL The coil to configure.  

TYP Configure the type of the coil: 

 

ABS - Absolute coil 

DIF - Differential 

TRG - Trigger 
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This can also be done by right-clicking in the coil of the Main 

Config table.  

BC Balance Coil if enabled. This coil will be balanced when 

BALANCE is clicked (see Toolbar Left on page 43). 

HN Hardware Null this coil if enabled. A hardware null will be 

performed on this coil when the HW NULL button is clicked (see 

Toolbar Left on page 43).  

RFT Sets the RFT gain value. This is an extra gain stage in the RFT 

module. 

CAP The OMNI-200 can apply a capacitance to one side or the other of 

a probe coil in order to balance the impedance (see Toolbar Left 

on page 43). This column shows the results. It can also be changed 

manually by clicking in a cell or the heading. 

NAME Enter a text label here to identify a coil if desired. This is not 

currently used in the acquisition & analysis software. 

 

 



3 Tester Configuration Dialog Core Star 
 

  
OMNI-200 Reference Manual (Rev 6.5) 64 of 101 

 

3.5 Options Tab 

 

The Options tab shows miscellaneous settings for the tester.  
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3.5.1 Coil Mapping Table 

 

This table is used to map physical tester coils to logical probe coils. For most probes this 

is a one-to-one mapping, which is the default, and need not be modified (see below). 

 

 
 

For array probes, where the physical probe coil changes based on the time slot, you must 

use this table to set the mapping. For example, for the MHI Intelligent probe, which has 

24 array coils and 2 bobbin coils, the mapping looks like this: 

 

 
 

In this case, for example, in time slot 3, tester coil 8 corresponds with probe coil 18. The 

coil displayed in the lissajous and other areas of the Acquisition & Analysis software is 

the probe coil, not the tester coil.  

 

The values in the table can be modified by clicking in a cell or the heading. For certain 

special probes, such as the I-Probe, the values can be set automatically using the Probe 

menu.  
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3.5.2 Alarms Table 

 

This section configures the OMNI-200 air detection. When the tester determines that the 

probe is in air, it can drive one of the Aux IO lines high. 

 

In the example below, if either the x or y value on channel 2 exceeds 75% of the range of 

a 16-bit integer, then AUX IO line 1 will go high and remain high for a minimum of 0.1 

seconds.  

 

 
 
The Air Out section has the following fields: 

 

Aux IO Line The physical IO line on the front panel of the tester to use for AIR 

OUT (see ???). If set to NONE, no signal will be output on the 

front-panel, however, the AIR signal between the OMNI-200 

tester-in-pusher and TrackDrive-200 Galil control board will still 

be driven (see ???). 

Pulse Width The minimum duration of the AIR OUT signal.  

Hi Inside If enabled, the alarm will be asserted when the the signal is inside 

the circle, otherwise, it will be asserted when it is outside.  

Invert If enabled, this will invert the polarity of the alarm signal driven on 

the Aux IO Line above. In other words, if enabled and the alarm is 

asserted, the output will be driven LO.  
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The Air Channel table configures which eddy current signals are used to detect air. The 

AIR OUT signal will be asserted if any of the eight channels is in air. This has the 

following columns: 

 

# The line of the table. 

AIR CHAN The eddy current channel to monitor. These are the same numbers 

displayed in the cells of the Main Config table. 

X and Y The x,y value of the center of the alarm circle in digital data units. 

RAD The radius of the alarm circle as a percentage of a 16-bit signed 

integer.  
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3.6 Scope Tab 

 

The Scope tab presents an oscilloscope style display of the signals being received by the 

tester coil inputs. The actual digital outputs of the coil ADC are shown along with other 

information about the current configuration. For the Scope to function, the software must 

be properly configured to communicate with the tester and the TESTER ON button must 

be clicked.  
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3.6.1 Scope Chart Display Parameters 

 

Directly above the chart are a number of fields that determine what data is displayed. 

 

 
 

These fields are defined as: 

 

Slot The time slot that is currently selected for viewing.  

Delay The delay in ns from the start of the time slot to the start of scope 

sampling. 

ddu/div The number of ADC digital data units per vertical division on the 

chart. 

Coil The tester coil currently selected for viewing.  

Decimate The scope can store a maximum of 4096 ADC samples. Since the 

clock rate of the OMNI-200 is 66 MHz, this would only allow for 

62 µs of total storage time. To overcome this limitation, decimation 

can be used to skip samples. If it is zero, all samples are stored, if it 

is 1, every other sample is stored. Higher values allow you to see a 

longer time period, but reduce the resolution at which you are 
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seeing it.   

µs/div The number of µs per horizontal division on the chart. 

 

 



3 Tester Configuration Dialog Core Star 
 

  
OMNI-200 Reference Manual (Rev 6.5) 71 of 101 

 

3.6.2 Scope Chart 

 

The Scope Chart shows the actual data along with cursors to make measurements and 

colored bars to display information about a given time period.  

 

 
 

The Scope chart has two vertical and two horizontal cursors. If the cursors are not visible, 

click in the light gray region above the chart to turn on the vertical cursors, and in the 

light gray region to the right of the chart for the horizontal cursors. Click and drag an 

existing cursor to move it. Middle-click on a cursor to remove it.  

 

At the bottom of the chart there are a series of colored bars that show information about 

that time period. The lines are: 

 

SAMPLE Blue ▄▄▄ during times when the sample is being taken. Note that 

the length of the segment closely matches the amount of time used 

shown in the Time Used status display in the lower left part of the 

dialog. In the case above, the vertical blue cursor is at t2 = 941 µs 

and the time used is 944 µs.  

SLOT Dark blue ▄▄▄  when a slot is being processed.  

DEMOD Green ▄▄▄  during the demodulation phase of each slot. The text 

within a bar shows the dynamic gain setting. 

Colored Bars 

Horizontal Cursors 

Vertical Cursors 

Scope Chart 
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GAIN The dynamic gain setting at the given time.  

SLOT # The time slot number at the given time.  
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3.6.3 Scope Chart Measurements 

 

Directly below the chart are the fields that display the cursor measurements.  

 

 
 

These fields are defined as follows: 

 

t1 The time value of the red vertical cursor. 

t2 The time value of the blue vertical cursor. 

dt dt = t2 – t1 if both vertical cursors are displayed.   

Freq Freq = 1.0 / dt. This can be used to verify the frequency of a signal. 

v1 The voltage, in ddu, of the red horizontal cursor. 

v2 The voltage, in ddu, of the blue horizontal cursor. 

dv dv = v2 – v1 if both horizontal cursors are displayed. 

Vrms The root-mean-square voltage of the signal between the two 
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vertical cursors. 
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3.6.4 Using the Scope to Determine Delay Values 

 

The Scope has many uses. One of the most important is to determine good values for the 

delay settings (see Delay Table on page 58). In the picture below, we can see that the 

signal has settled after about 8.4 µs on coil 1. 

 

 
 

It’s important to check all the coils. In this case, about 10 µs would have been enough 

settling time and the delays for slot 1 could have been set to 10.  

 

Use horizontal cursors to see 
where the signal has settled 
to the same height. 

Transient 

Use vertical cursor to 
mark where the transients 
have settled.  
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3.7 Waveform Tab 

  

This tab displays the waveform that will be output to the probe for a particular driver 

during a given time slot. This is a mathematical representation only and is based on the 

configuration settings, including frequency, drive, and phase offset, in the Main Config 

table.  

 

 
 

The cursors and associated information work the same way as in the Scope tab (see 

Scope Tab on page 68). The fields above the chart are: 

 

Driver Choose the driver to display. 

Slot The time slot to view. 

ddu/div The number of digital data units (ddu) in each vertical division.  

µs/div The number of µs per horizontal division of the chart.  

 

3.7.1 Simultaneous Injection Waveforms 
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The Waveform tab is most useful when using simultaneous injection. For example, if we 

configure two frequencies in time slot 1 as shown: 

 

 
the waveform will appear as follows: 

 

 
 

The individual components are shown in color (in this case 200 KHz in green and 400 

KHz in red) and the composite waveform is always shown in black. The composite 

waveform is the sum of all the time slices for that driver for that slot and is the signal that 

will actually be driven to the probe. 

 

If the total drive is too high, as is the case with the config below: 

 

 
the parts of the waveform that exceed the maximum drive will be shown in red: 
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However, it is important to note that the sum of the drives is not necessarily limited to 

100%. For example, the following, where the total is 112%, is fine: 

 

 
This occurs because the peaks of the individual components do not occur at the same 

time: 

 

 
 

Parts of the composite 
waveform that exceed 
the maximum drive are 
shown in red. 
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In some cases it is also possible to adjust the phase offsets of some components in order 

to move the humps and increase the drive. 
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3.8 Frequency Sweep Tab 

 

This tab is used to perform a frequency sweep of the probe and material under inspection. 

This can be used to determine the resonant frequency and optimum test frequencies.  

 

 
 

3.8.1 Frequency Sweep Controls 

 

There are a number of buttons above the frequency sweep chart that control the display 

and perform the sweep: 

 

 
 

SWEEP Click this button to perform that actual frequency sweep. It will not 

be active until the NULL step has been performed. 

NULL Click this button to compute the baseline impedance at each 

frequency. 
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COILS 1 to 8 Click these buttons to determine which coils will be displayed. The 

color of the button is the same as the color of that coils plot. For 

example, coil 1 is red and its sweep results are shown in red in the 

chart. 

ddu/div Click to adjust the number of digital data units per vertical division. 

KHz/div Click to adjust the frequency increment in each horizontal division 

of the plot. 

Min Click to adjust the starting frequency of the sweep. 

Max Click to adjust the ending frequency of the sweep. 

Inc Click to adjust the frequency increment of the sweep. The sweep 

will start at the Min value and increment by this amount until the 

Max value is reached.  
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3.8.2 Performing a Frequency Sweep 

 

1. Select which coils to display by clicking on the coil number. In this case, only coil 

1 is selected. 

 

2. Select the frequency range by choosing a Min frequency, Max frequency, and 

Inc. Make sure the Inc is not too small or the sweep will take a very long time. 

 

3. Move the probe to a clean section of tubing and click NULL. The percentage 

done will be displayed in the status bar but nothing will be displayed in the chart 

at this point. 

 

4. Move the probe near a defect and click SWEEP. Once the sweep is complete, the 

impedance at each frequency will be displayed.  

 

In this case, the resonant point is around 100 KHz.  
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3.9 Status Tab 

 

This tab displays various status information read from the tester. The information is read 

once per second and you will receive errors if the software cannot communicate with the 

tester. 
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3.9.1 Tester Info 

 

 
 

This frame displays the following information: 

 

Firmware Desc This will always be OMNI-200. 

Firmware Date The creation date of the firmware that is stored in the tester.  

Firmware Rev The revision number of the firmware that is stored in the tester. 

This must be compatible with the software used to communicate 

with tester. 

Board ID The OMNI-200 supports a variety of probe modules. Each has a 

unique ID number that enables the configuration software to 

identify it and its capabilities (see ???). 

MAC ID The last two segments of the testers Ethernet MAC address 

expressed as a decimal number. 

MAC Address The Ethernet MAC address of the tester.  

SN The serial number of the tester that is assigned during 

manufacturing. It can also be modified using the CoreStar OMNI-

200 ASME/JEAG calibration software.  

Cal Type The type of calibration most recently performed on the tester. 
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Possible values are: 

 

• MANUAL 

• ASME 

• JEAG 

 

If the tester was calibrated with the OMNI-200 ASME/JEAG 

Calibration software, the type will be ASME or JEAG. Otherwise, 

it will be MANUAL. 

Cal Date The date the latest calibration was done.  

Probe Attached ON if a probe is attached and OFF otherwise. For units other than 

tester-in-pusher, this is always ON. 

Probe Changed ON if the probe was removed since the last time the tester was 

turned on. If it has been changed, you may need to rerun the 

standard pulls. This feature only functions on tester-in-pusher units. 

 

3.9.2 Errors 

 

 
 

FPGA FIFO Errors The number of times the First In First Out (FIFO) buffer of the 

FPGA has overflowed since the last time the tester was turned 

on.  



3 Tester Configuration Dialog Core Star 
 

  
OMNI-200 Reference Manual (Rev 6.5) 86 of 101 

 

CPU FIFO Errors The number of times the FIFO in the testers CPU has overflowed 

since the last time the tester was turned on. 

Trigger Errors These only occur if the tester is triggered externally or by 

encoder. If the triggers occur more quickly than the maximum 

sample rate for the current configuration, the sample will be 

missed and the error count is incremented. 

 

WARNING: Using the Scope tab will cause FPGA and CPU FIFO errors since the 

tester is on but the data is not being read. These errors are not important 

and will be cleared the next time the tester is turned on. 

 

3.9.3 Aux IO 

 

This section displays the current state of the testers auxiliary IO lines. If a line is high, it 

will be shown depressed and green. 

 

 
 

OUTPUTS 7 to 0 Displays the status of the output lines. The user can also click on a 

line to toggle its state. 

Click on the pin number to 
change a single output. 

Left-click here to set 
all the outputs.  
Middle-click to clear 
them. 
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Left-click on OUTPUTS to make them all high. Middle-click to 

make them all low. 

INPUTS 7 to 0 A read-only display of the status of the input pins. If nothing is 

connected, these are all pulled high.  

 

 

3.9.4 Sensors 

 

This section displays the current value of the OMNI-200 voltage and temperature 

sensors. 

 

 
 

CH The sensor channel. 

MEAS The current value 

DESC A description of the sensor channel or the expected value.  

 

If the measured value is outside the acceptable range, it will be shown in red.  
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4 Gain Calibration Tool 
 

This tool is used to calibrate the OMNI-200 dynamic gain amplifiers and display the 

results. It can be accessed using the Gain Cal choice from the Tools menu. This tool is 

normally only used during manufacturing and is not typically needed by users.  

 

 
 

WARNING: The Ok and Cancel buttons in this tool simply close the dialog. The 

Cancel button will not undo the actions of the CALIBRATE button. 

 

4.1 Gain Cal Menu 

 

The only menu is the File menu: 

 

Print Print the table to a file. 
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Export Export a text version of the calibration to a text editor. 

 

4.2 Gain Cal Toolbar 

 

The toolbar contains the following buttons: 

 

READ CAL When the tool is first displayed, it will be blank. Click this button 

to read the calibration information from the tester and display it in 

the table. The caption will display the MAC address of the tester. 

CALIBRATE Click to initiate the calibration. This requires the special gain 

calibration module, which has a Board ID of 0, and will have no 

effect if a standard probe module is attached. This is normally only 

done during manufacturing. 

 

4.2.1 Gain Cal Table 

 

The calibration table has the following fields: 

 

LINE An index number for that line of the table. 

FREQ The frequency at which that section of the calibration was 

performed. Whenever the user downloads a configuration, the 

section of the calibration with the closest frequency is used for 

dynamic gain corrections.  

 

In practice, the dynamic gain amplifiers have a nearly flat 

frequency response, but the calibration is done at a wide range of 

frequencies to produce the best possible results. 

NOM GAIN IDX The index, in binary, of the gain stage of the amplifier at that line 

of the table. The OMNI-200 dynamic gain amplifiers have eight 

stages. 

NOM GAIN DB The nominal gain, in dB, at that gain stage of the amplifier. 

NOM GAIN V/V The nominal gain, in terms of output divides by input, at that stage 

of the amplifier. 
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COIL GAIN  

1 to 8 

Each column displays the measured gain for that amplifier gain 

stage for that coil. Each cell is color coded based on the its variance 

from the nominal value. If it is white, it is within 10%. Otherwise, 

the color coding shown at the bottom of the table is used. 

 

A certain variation from the nominal is perfectly normal and not an 

issue for concern; that is the purpose of the calibration. If any cells 

are in red (i.e. greater than 20% error), that may be an issue for 

concern. 

 

Clicking on a row in the table will highlight the row and display its variance from the 

nominal values below the table. For example, row 145 is selected above 

 

 
  

This cell is yellow since the variance is 
10.363% which is greater than 10% but 
less than 20%. 

Color coding: 

• Yellow if between 10% and 20% 

• Red if greater than 20%. 
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5 Hardware Null Tool 
 

The Hardware Null tool displays a table of digital offsets used to center the eddy current 

data around zero. These offsets are computed when you click the HW NULL button (see 

Toolbar Left on page 43). 

 

To access the tool, choose Hardware Null from the Tools menu. 

 

 
 

5.1 Hardware Null Menu 

 

The File menu has the following choices: 

 

Export Export a text version of the null results to a text editor. 

 

5.2 Hardware Null Table 

 

The table contains the following fields: 

 

SLT The time slot. 

F The frequency number (i.e. time slice) in the given slot. 
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COIL n 

X and Y 

For each coil, the offset applied to center the X and Y components 

for the given time slot and time slice. Only nonzero values are 

shown. 
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6 IP Setup Utility 
 

The OMNI-200 uses the Internet Protocol (IP) to communicate over the network. The IP 

Setup utility is used to help properly configure the tester to communicate with the 

acquisition software.  

 

Every piece of equipment (i.e. node) on the network has a unique physical address called 

its MAC (Media Access Control) address. This is six bytes in length and is assigned by 

the manufacturer of the equipment. Each vendor is assigned a block of addresses by the 

IEEE in order to avoid conflicts. All OMNI-200 testers begin with 00:14:B3 and an 

example MAC address is 00:14:B3:00:00:13 (this is the tester used in t. 

 

Each node also has a four byte logical address (e.g. 192.1.6.4), called its IP address, used 

by end users to refer to a machine. If the node is on the Internet, it must be a globally 

unique address. In most cases, eddy current testing is done on a private local network. It 

is always safe to use IP addresses in the range 192.168.0.0 to 192.168.255.255. These are 

reserved and will not be used by any node on the Internet.  

 

To access the IP Setup utility, choose IP Setup from the Util menu.  When the utility 

starts up, it broadcasts a message on the local network asking all OMNI-200 testers to 

respond with their IP address. This requires that broadcast packets be allowed on your 

network (some firewalls will block them). 

 



6 IP Setup Utility Core Star 
 

  
OMNI-200 Reference Manual (Rev 6.5) 94 of 101 

 

 
 

The EQUIPMENT table at the top displays the following information: 

 

# The index of this row of the table. 

SET • YES if the IP ADDR displayed has actually been stored to 

the tester.  

• NO if the user has modified the IP address but not yet 

stored it in the tester.  

MAC The MAC address of the given tester. The MAC address of each 

tester is printed on a label on the front panel.  

IP ADDR The IP address of the tester. 

TYPE The type of equipment. Currently, this will always be OMNI-200. 

 

To establish communication between your computer and the tester, their IP addresses 

must be compatible. This is determined by what is called the subnet mask. The default 

subnet mask on Microsoft Windows systems is 255.255.255.0.  
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A simplified explanation is that if an octet of the subnet mask is 255, that octet of the IP 

address must be the same for all nodes on the network. The remaining octets of the IP 

address must be different for each node on the network.  

 

The subnet mask of the computer is shown in the lower table, and in this case is 

255.255.255.0. Thus the first three octets of each IP address must be the same for all 

nodes, and in this case, they are all 192.1.6. The fourth octet must uniquely identify each 

node. In this case, the first tester is at 42, the second at 43, and the computer itself is at 4. 

 

If a testers IP address is not compatible with the computer’s IP address and subnet mask, 

the conflict will be shown in red: 

 

 
 

The third octet is red because the computers subnet mask has a 255 in the third octet and 

the third octet of its IP is 6, so the third octet of the tester must be 6 as well. If the 

computers subnet mask were 255.255.0.0, this IP address would not be in conflict.  

 

This octet is incompatible 
with the subnet mask and IP 
address of the computer. 
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6.1 Choosing a Tester from the List 

 

To connect to a tester: 

 

1. Choose a tester from the list based on its MAC. 

 

2. Click in the # column of that tester. 

 

3. Click OK. 

 
The IP Setup utility closes and the IP address of the tester you selected will be shown in 

the IP Address field in the OMNI-200 configuration dialog.  

6.2 Changing a Testers IP Address 

 

You may need to modify a testers IP address in order to make it compatible with your PC 

or to make sure it is unique. 

 

To change the IP address: 

 

1. Click on the parts of the address you wish to change. Make sure no parts are 

shown in red. This will cause the SET column of that tester to change to NO.  

 

2. Click on the NO. This will send the new IP address to the tester where it will be 

stored in the FLASH and change the SET column back to YES.  

 

3. Click OK to close the IP Setup utility and use the new IP Address. 

 

6.3 DHCP and BOOTP 

 

The OMNI-200 supports an alternative to explicitly setting the IP address of each tester, 

namely to use BOOTP (Bootstrap Protocol) or DHCP (Dynamic Host Configuration 

Protocol). This requires a BOOTP or DHCP server on your network. The administrator of 

the server will need to put the MAC address of each OMNI-200, along with the desired 

IP address into the list of nodes. Whenever the OMNI-200 is powered on, it sends out a 

BOOTP packet (which is compatible with DHCP as well). If a server sends a BOOTP 

response, which will contain the desired IP address,  the OMNI-200 will use that instead 

of the one stored in its FLASH.  

 

6.3.1 Disabling DHCP on Your Computer 

 

Sometimes a users computer is mistakenly setup in DHCP mode when there is no DHCP 

server on the network. In this case, neither the computer or OMNI-200 will be configured 
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properly. This often occurs if a user puts his laptop into DHCP mode in order to connect 

to a wired network in a hotel, and forgets to disable DHCP when returning to site.  

 

If the computer is in DHCP mode, the IP Setup utility will not show an information for 

testers or the computer: 

 

 
 

To disable DHCP on a computer running Windows XP: 

 

1. Open Network Connections in the Control Panel. 

 

2. Select Local Area Connection form the list of Network Connections. 

 

3. In the Local Area Connections Status dialog, click Properties. 

 

4. Select Internet Protocol (TCP/IP) in the table of protocols. 

 

5. Click Properties. 

 

In DHCP mode, the Internet Protocol (TCP/IP) Properties dialog will have Obtain 

an IP address automatically selected: 
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6. Select Use the following IP address to disable DHCP: 
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7. Set the IP address: and Subnet mask: of the computer to a value compatible 

with the rest of your network. These are the values for  you computer. 

 

8. Click OK to close the Internet Protocol (TCP/IP) Properties dialog. 

 

9. Click OK in the Local Area Connections Properties dialog. 

 

10. Click Disable in the Local Area Connection Status dialog. This will disable the 

network and close the dialog returning you to the Network Connections dialog.  

 

11. Double-click on Local Area Connection in the Network Connections dialog to 

re-enable the network. 

 

12. Click Close in the Local Area Connections Status and close the rest of the 

dialogs. Your computer should now have the new network settings in effect. 
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NOTES: • The actual values displayed on your system will likely differ from 

this example.  

 

• The values for the Default Gateway and DNS servers are usually 

not relevant to communicating with the OMNI-200. They are 

typically for communicating with nodes outside the local network 

(e.g. the Internet). 

 

• If you wish to enable DHCP instead of disabling it, simply 

modify the above steps by checking the Obtain an IP address 

automatically and Obtain DNS server address automatically.  
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